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Introduction
The Windows application program EasyGSM
allows you to recall the phonebook, SMS, and
call data stored in your GSM phone into your
computer, and edit, delete, or create new data. 
When you install the EasyGSM program, the
data in your GSM phone is automatically
loaded to the computer. Afterward, you can
reload data from the phone to the computer
any time you want. With EasyGSM, you can
easily edit and create phonebook or SMS data.
Each time the data is changed, the information
is automatically downloaded to the GSM
phone. 
You can also make a call using the data on the
EasyGSM program. The last dialed numbers
are automatically stored up to 10 in EasyGSM.

Note: Instructions in this guide assume that
Mobile Data Soft Driver has been installed in your
computer, and an AT-compatible GSM phone (i.e.
the SGH series having data functions) is  
connected to the computer using the supplied
interface cable.
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1. Start your Windows, if not already started.

2. Insert the EasyGSM installation CD-ROM into your
CD-ROM drive.

3. From the Start menu, select Run. The Run dialog
box appears.

4. Type d: \ EasyGSM\disk1\setup.exe (where d:
is your CD drive – most CD drives are either  d: or
e: ) in the Open box, and click OK.

5. Follow the instructions on the screen.

Installation

To install EasyGSM software, your computer must
have at least the following system configuration: 

• IBM or IBM compatible computer with 486SX or
higher processor 

•  Windows 95

• 3 MB or higher RAM

• Free disk space of at least 6 MB

• Mobile Data Soft Driver installed

• GSM phone that supports AT command 
(i.e. the SGH series having data functions)

• Interface cable supplied with Mobile Data Soft
Driver

System Requirement Installation Procedure

I n s t a l l a t i o n
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Getting Started
1. Before you start EasyGSM program, make sure that

your GSM phone is connected to the computer seri-
al COM port using the supplied interface cable. 

Note: If you start EasyGSM program without a
GSM phone connected, EasyGSM asks
whether you want to work off line.

2. From the Start menu, select Programs.

3. Select Samsung EasyGSM, then select EasyGSM.
The SAMSUNG EasyGSM window appears.

How To Uninstall EasyGSM

1. Start your Windows, if not already started.

2. From the Start menu, select Programs.

3. Select Samsung EasyGSM1.0 from the Programs
list. 

4. Select Uninstall.

I n s t a l l a t i o n
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The following is the EasyGSM main window:

Menu Bar
Each menu has pull-down submenus.
Help gives on-line help.

Status Bar 
Displays the current activity. You can select
this bar to appear in or hide from screen using
View menu.

Data loaded 
from SIM

Data
loaded
from
phone’s
memory

Function Tabs
Allows you to select the active
field; PhoneBook, SMS, Call Log.

Data in PC

Getting Started Getting Started

Tool Bar 
Gives a quick access to convenient functions. You
can select this bar to appear in or hide from the
screen using the View menu.
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Opens the Make New Phone Book or
Make New SMS dialog box depending on
your current working field. Allows you to
create a new phonebook or new SMS
message.

Reloads data from the phone to
EasyGSM.

Opens the Make Call dialog box, contain-
ing the last dialed number and name. It
allows you to redial the last number.

Opens the Make Call dialog box. After you
select the desired number from phone-
book, SMS, or call log field, click this
icon. The Make Call dialog box shows
information about the selected item. Click
on the        button in the dialog box to
start dialing.

Reserved

Reserved

Makes a copy of the selected Phonebook
item(s) into the SIM field.

Makes a copy of the selected Phonebook
item(s) into the MS field.

Makes a copy of the selected Phonebook
item(s) into the PC field.

Activates Filter to start searching a num-
ber or name you have entered in the Filter
Setting dialog box.

Executes the program currently selected
using the Linker menu.

Displays version information.

Exits EasyGSM.

Using Tool Bar

Getting Started Getting Started
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PhoneBook

When you start EasyGSM, you can see the phonebook
data loaded from your phone. You can edit or delete the
phonebook data, or create new phonebook data on your
computer. Your phone will be automatically updated.

To Edit PhoneBook

1. Make sure that the EasyGSM window shows the
phonebook data. If not, click the Phone Book tab.

2. Find the item you want to edit. If you click the title
(No, Name, or Phone Number) at the top of each
column in the list box, the contents in the selected
column are sorted in alphabetical order or numeri-
cal order.

Click the PhoneBook tab to
load the phonebook data.

Each time you click a title, 
the contents are sorted in alpha -
betical or numerical order.

3. Click the item you want to edit. The selected item
is highlighted.

4. Double-click the desired item. The View/Edit
Phone Book dialog box appears, and shows the
current setting of the selected item.

5. Change the settings, then click OK to save them.

Click the desired item to select.

P h o n e B o o k
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To Create New PhoneBook Data

1. Make sure that the EasyGSM window shows the
phonebook data. If not, click the Phone Book tab.

2. Click         icon in the tool bar. You can also use
New Phone Book Data from the Phone Book
menu.

3. The Make New Phone Book dialog box appears, and
shows the first available empty location under the
memory you have last worked (SIM, MS, or PC).
You may change the location. 

4. Fill in the boxes available in the Make New
PhoneBook dialog box. 

In SIM or MS memory, you can enter location num-
ber, name, and main phone number while PC memo-
ry allows you to enter additional information which
are not available in SIM and MS memory
(i.e. Email Address). 

5. When completed, click Make New.

Click on this icon to start dialing.

Notes: 
• If the selected memory is full, you’ll get an error

message.
• If you try to create data in the location which a

number is already stored, a warning message
appears, prompting users to select to overwrite
with new number, or cancel the creating.

P h o n e B o o kP h o n e B o o k
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To Delete a Single PhoneBook 

1. Make sure that the EasyGSM window shows the
phonebook data. If not, click the Phone Book tab.

2. Click the item(s) you want to delete.

3. When the desired item(s) is(are) highlighted, select
Delete Phone Book from the Phone Book menu.
The selected item is deleted.

To Copy PhoneBook

You can copy phonebook in one field (SIM, MS, or
PC) to another phonebook field.

1. Select the phonebook item(s) you want to copy.
The selected items are highlighted.

2. Click         to copy to SIM,         to copy to MS,
to copy to PC.

You’ll see the selected items copied onto the
selected field.

To Delete All PhoneBook 

1. Make sure that the EasyGSM window shows the
phonebook data. If not, click the Phone Book tab.

2. From the Phone Book menu, select Delete All
Phone Book. You are prompted to confirm the dele-
tion. Click Yes to confirm it. All information in the
phonebook is deleted.

P h o n e B o o k

A quick way to select several items in the same field

• To select several items scattered, click each item while you
press the Control key on the keyboard.

• To select several items close to each other, click the first item,
then while you press the Shift key on the keyboard click the
last item. All the items between the first and the last are high-
lighted.

P h o n e B o o k
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Your EasyGSM stores the last 10 dialled  numbers.
Each time you make a call through EasyGSM, the
newly dialed number is stored and the oldest number
is automatically erased. You can recall the numbers
any time you want and redial them.

1. Make sure that the EasyGSM window shows the
phonebook data. If not, click the Phone Book tab.

2. From the Phone Book menu, select Redialling
Phone Book. The Redialling PhoneBook dialog box
appears, and shows the names of the last dialed
calls. If you have not entered a name when you
make a call, only the phone number appears.

3. Click the name (or number) you want to redial. The
selected name and phone number appear at the
bottom of the dialog box.

4. To redial, click Make Call. The Make Call dialog
box appears, and shows the number and name you
selected in the Redialling PhoneBook dialog box.

5. If necessary, select additional settings. 

6. To start dialing, click        . 

1918

Redial 
Using EasyGSM, you can see all SMS data stored in
the SIM, edit or delete the data, and create a new
message. You can also reply to the message.

To Display Messages

1. In EasyGSM main window, click the SMS tab. You
can see all SMS messages you have not read yet.
If necessary, select Reload SMS from the SMS
menu to reload SMS data from the phone to your
EasyGSMwindow.

2. Click the desired message type. The messages in
the selected type(s) appear in the list.

SMS (Short Message Service)

Click the SMS tab to display SMS data.

Click the desired message type. Only the messages 
of the selected type appear.

Not Read: The messages received but not read yet.
Read: The messages received and already read. 
Not Sent: The messages stored but not sent yet.
Sent: The messages stored and already sent.
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3. Click the message you want to view in detail. The
selected message is highlighted, and the message
box at the bottom shows the full message con-
tents.

If you want to view additional information, double-
click the desired message. The View Message dia-
log box appears and you can see the detailed
information about the selected message.

5. If you want to send the message, select Make
Call from the Call Control menu in the menu bar
or click        icon in the tool bar. The Make Call
dialog box appears, containing the selected infor-
mation.

6. To start sending, click        .

Click the message to select.

S M SS M S

To Create a New Message

1. In EasyGSM main window, click the SMS tab. You
can see all SMS data stored in the SIM.

2. From the SMS menu, select Make New SMS
menu. You can also use         icon in the tool bar.

3. The Make New Message dialog box appears. Fill in
the boxes available. 

4. If you want to send the message, click SEND. If
you want to save the message, click SAVE. The
message is created as a Not Sent type.
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Using SMS Menu

You can select the following SMS menus after you
select the desired message from the list.

Reply to Message: allows you to reply to the number
you have received with your mes-
sage.

Forward Message: allows you to forward the mes-
sage to the location you specify.

Resend Message: allows you to resend the selected
message.

Delete Message: allows you to delete the selected
message.

Delete All Messages: allows you to delete all the
SMS messages.

Reload Messages: allows you to reload the SMS data
from the phone to EasyGSM.

S M S

This feature helps you remember whom you called,
who called you, the duration time, and so on. To see
the information, click the Call Log tab in EasyGSM
main window.

Call Log

Click the Call Log tab to display information 
about incoming and/or outgoing calls 

Click the desired call type. The check symbol appears 
when selected. Only the calls in the selected type 
appear in the window.

Outgoing: Calls recently made.
Incoming: Calls recently received. 
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You can make a call on EasyGSM. The dialed number
is stored in the redial phonebook memory of
EasyGSM.

1. From the Call Control menu, select Make Call.
The Make Call dialog box appears.

Call Control

If you select Make Call menu after you select the
desired item from the phonebook or SMS memory,
the Make Call dialog box appears, containing the
information about the selected item.

2. Fill in the boxes to enter phone number, name, and
service type. If you want to send a message,
select the SMS type, and enter the desired mes-
sage.

3. To start dialing, click        . 

2. The Filter Setting dialog box appears. Enter the
name and/or phone number you want to find. You
may enter the first few characters as long as you
know. When completed, click SET.

You can find a number or name in the phonebook or
SMS memory using the Filter menu.

Setting Filter

1. From the Filter menu, select Filter Setting.

Searching Data
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3. Click the         icon in the tool bar, or select Filter
from the Edit menu, then finally select Filter. The
window shows all the names or phone numbers
beginning with the name or number you have
entered.

Filter icon selected

4. If necessary, select the SMS, Phone Book, or
Call Log tab. Each time you click SMS, or
PhoneBook, or Call Log tab with Filter selected,
this program shows the number and/or name you
want to find.

Searching Data

2. The Open dialog box appears. Select the program
you want to open, then press Open. The selected
program is now linked with your EasyGSM.

3. To execute the linked program, select Execute
Program from Linker menu or click the         icon
in the tool bar. Where xxx is the linked program
name.

You can execute a file in any other directory without
closing EasyGSM. 

1. To select the desired file, select Select the
Program you want from the Linker menu. 

Linker
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